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CERTIFICATE OF CONFORMANCE 
 

Programmable Ashing Furnace 
K24410, K24419, K24420, K24429, K24430, K24439 

 
 

This certificate verifies that part number K244XX, Programmable Ashing Furnace, 
was manufactured in conformance with the applicable standards set forth in this 
certification. 
 
Specifications:    ASTM D482 
     ASTM D874 
     ASTM D3174 
     ASTM D4422 
     ASTM D5184 
     IP 4 
     IP 163 
     ISO 3987 
     ISO 6245 
     NF M 07-045 
     DIN 51352 
     DIN 51575 
 
This unit is tested before it leaves the factory, to ensure total functionality and 
compliance to the above specifications and ASTM standards. Test and inspection 
records are on file for verification. 

                 
Jesse Kelly             
Application Engineer 
Koehler Instrument Company 
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1 Introduction 
 

The Koehler K244XX Ashing Furnace is the 
latest design for performing Ashing of petroleum 
products according to the ASTM test methods 
listed in Section 1.2.  

 
This manual provides important information 

regarding safety, technical reference, installation 
requirements, operating condition specifications, 
user facility resource requirements, and operating 
instructions for the Koehler Muffle Furnace. This 
manual should also be used in conjunction with 
applicable published laboratory procedures. 
Information on these procedures is given in 
section 1.2. 
 
1.1 Koehler’s Commitment to Our 

Customers 
 

Providing quality testing instrumentation and 
technical support services for research and testing 
laboratories has been our specialty for more than 
50 years. At Koehler, the primary focus of our 
business is providing you with the full support of 
your laboratory testing needs. Our products are 
backed by our staff of technically knowledgeable, 
trained specialists who are experienced in both 
petroleum products testing and instrument service 
to better understand your requirements and 
provide you with the best solutions. You can 
depend on Koehler for a full range of accurate and 
reliable instrumentation as well as support for your 
laboratory testing programs. Please do not 
hesitate to contact us at any time with your 
inquiries about equipment, tests, or technical 
support. 

 
Toll Free: 1-800-878-9070 (US only) 
Tel: +1 631 589 3800 
Fax: +1 631 589 3815 
Email: info@koehlerinstrument.com 
http://www.koehlerinstrument.com 

 
1.2 Recommended Resources and 

Publications 
 

1. American Society for Testing and Materials 
(ASTM) 
100 Barr Harbor Drive 
West Conshohocken, Pennsylvania 19428-
2959, USA 
Tel: +1 610 832 9500  
Fax: +1 610 832 9555 
http://www.astm.org 
email: service@astm.org 

 
ASTM Publication: 
• ASTM D482: Standard Test Method for 

Ash from Petroleum Products 
• ASTM D874: Standard Test Method for 

Sulfated Ash from Lubricating Oils and 
Additives 

• ASTM D3174: Standard Test Method for 
Ash in the Analysis Sample of Coal and 
Coke from Coal  

• ASTM D4422: Standard Test Method for 
Ash Analysis in Petroleum Coke 

• ASTM D5184: Standard Test Methods for 
Determination of Aluminum and Silicon in 
Fuel Oils by Ashing, Fusion, Inductively 
Coupled Plasma Atomic Emission 
Spectrometry, and Atomic Absorption 
Spectrometry  

 
1.3 Instrument Specifications 
 

Models: K24410,K24420, 
K24420-18L, K24430 
K24419,K24429, 
K24429-18L, ,K24439 

Electrical 
Requirements: 

 
115V 60Hz 1 ph 
230V 50/60Hz 1 ph 

Temperature Range: Ambient to 1200°C 

Temperature Control 
Accuracy: 

 
± 1 °C 

Temperature Control 
Uniformity: 

 
± 3 °C 

Temperature Control 
Resolution: 

 
± 0.1 °C 

Oven Volume: 0.17 ft3. model: 5 L 
0.52 ft3. model: 15 L 
0.64 ft3. model: 18 L 
1.41 ft3. model: 40 L 
 

Power: K2441X: 2700 W 
K2442X: 5500 W 
K2443X: 11,000 W 

Chamber Internal 
Dimensions: 

(wxdxh,in.(cm) 

 
 K2441X:8x7x5 
(20.32x17.78x12.70)  
K2442X 9x13x7 
(22.86x33.02x17.78)  
K2443X: 13x19x10 
(33.02x48.26x25.40) 

http://www.koehlerinstrument.com/
http://www.astm.org/
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2 Safety Information and Warnings 
 

Safety Considerations. The use of this 
equipment may involve hazardous materials and 
operations. This manual does not purport to 
address all of the safety problems associated with 
the use of this equipment. It is the responsibility of 
any user of this equipment to investigate, 
research, and establish appropriate safety and 
health practices and determine the applicability of 
regulatory limitations prior to use. 
 
Equipment Modifications and Replacement 
Parts. Any modification or alteration of this 
equipment from that of factory specifications is not 
recommended voids the manufacturer warranty, 
product safety, performance specifications, and/or 
certifications whether specified or implied, and 
may result in personal injury and/or property loss. 
Replacement parts must be O.E.M. exact 
replacement equipment. 
 
Unit Design. This equipment is specifically 
designed for use in accordance with the applicable 
standard test methods listed in section 1.2 of this 
manual. The use of this equipment in accordance 
with any other test procedures, or for any other 
purpose, is not recommended and may be 
extremely hazardous. 
 
Chemical Reagents Information. Chemicals and 
reagents used in performing the test may exhibit 
potential hazards. Any user must be familiarized 
with the possible dangers before use. We also 
recommend consulting the Material Data and 
Safety Sheet (MSDS) on each chemical reagent 
for additional information. MSDS information can 
be easily located on the internet at 
http://siri.uvm.edu or http://www.sigma-
aldrich.com. 
 
Disposal. Upon delivery the furnace does not 
contain any material which is to be classified as 
hazardous waste.  However, process residues 
may collect in the insulation during operation.  
These may be dangerous to health and/or 
dangerous to the environment.  
 
Therefore we recommend proceeding as follows: 

• Remove electrical components and dispose of 
as electrical waste. 

• Remove insulation and dispose of as special/ 
hazardous waste (wear a protective mask P2, 
protective gloves and a protective suit). 

• Dispose of the housing as scrap metal 
 
3 Getting Started 

 

The instructions for preparing the equipment 
assume that the user is aware of the contents of 
this document, which lists the warranty conditions 
and important precautions. 
 
3.1 Unpacking 

 

Carefully unpack and place the instrument and 
accessories in a secure location. Ensure that all 
parts listed on the packing list are present. Inspect 
the unit and all accessories for damage. If any 
damage is found, keep all packing materials and 
immediately report the damage to the carrier. We 
will assist you with your claim, if requested. When 
submitting a claim for shipping damage, request 
that the carrier inspect the shipping container and 
equipment. Do not return goods to Koehler without 
written authorization.  
 
3.2 Setup 
3.2.1 Installation Site 

Place the furnace on a non-flammable support 
(stone, metal or similar).  Keep a safe distance 
from flammable components, 0.5 m from the 
furnace sides and 1 m from the top.  The minimum 
distance between the furnace sides and non-
flammable materials can be reduced to 0.2 m. 
 
Ventilation. Provide sufficient room ventilation to 
carry off exhaust heat and gases which develop 
during the process.  Non-observance can result in 
a fire risk and danger to health. 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.sigma-aldrich.com/
http://www.sigma-aldrich.com/
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3.2.2 Assembling the Ventilation Pipe 

 
• The Ventilation Chimney must be attached to 

the top of the furnace using the 3 supplied 
screws. 

 
• In all cases, we recommend connecting the 

furnace to an exhaust ductwork, leading the 
arising gasses out of the facility 

 
• A standard ventilation pipe of metal with 

NW80 – NW 210 can be used.  It must be laid 
at a constant slope and fastened to the wall or 
ceiling.  

 
• Caution: The exhaust gases can only be 

carried off if the room is ventilated by a 
corresponding fresh air opening. 

 
3.2.3 Electrical Connection 

 

• Attach the correct plug to the power supply 
cord(s) and connect the main plug in a 
corresponding receptacle which is protected 
sufficiently depending on the rated power of 
the furnace.  If the furnace is ordered / 
delivered without a plug, a qualified electrician 
must connect the furnace. 

• NOTE: Using extension cables and/or junction 
boxes may lead to a reduced furnace output 
due to the voltage drop in the lines.  The 
power is also reduced if the connection line to 
the junction box is very long, and the furnace 
will not reach its nominal temperature.  Please 
have the connection checked by an 
electrician.  The voltage may not drop below 
the rated load by more than 10%. 

 
WARNING: For safety, disconnect the power 
when performing any maintenance and/or 
cleaning.  

 
3.2.4 Initial Heating Procedure 
 

• To dry out the brick lining and to create an 
oxide protection layer on the resistance wire, 
an initial heat run must be performed prior to 
testing.  This may cause an unpleasant smell.  
Provide sufficient ventilation. 

• Heat the empty furnace up to 1050 ºC over the 
course of six hours.  At each change rise in 
temperature, run the AUTO TUNE on the 
tuning page.  Once 1050 °C is reached, 
maintain this temperature for one hour, and 
then let the furnace cool down on its own. 

• The furnace is now ready to operate. 
 
4 Temperature Controller 
 

4.1 Description of Controller 
4.1.1 Main Breaker and Power Switch/ 

Control Current Switch 

The main breaker is located on the right rear 
bottom corner and the power switch / control 
current switch is located on the right side of the 
control panel.  Stop running a heating program 
before turning off the furnace with the power 
switch. 
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4.2 Basic Controller Operation 
 
This section is designed to help guide you through the touch screen interface and menu structure, so that you 
can navigate through the various operation, monitor and setup screens and learn how to use them.   
 
Touch Screen Interface 
 
The display is split into two sections; the icon bar and main display area. 
 

 
Single Loop View Screen 

 
 

        
 
 

        
 
 

        
 
 

        
 
 

 
 
   

Main Display 

Icon Bar 

The menu icon will open the main menu for navigating to the different control and 
monitoring screens.  Menu items will dynamically appear providing available options 
based on the system area the user is in, i.e., security, data logging, setup, etc. 
 
 
The information (help) icon will display text based help associated with the current 
screen.  Help is available in 28 languages based on the user selection in the offline 
setup of section of the display. 
 
 
The home icon will return the user to the main view from anywhere in the the display 
application.  The main view is set by the OEM in the the display configuration and can 
be the single or dual loop, chart, alarm, alarm history, event or digital IO view. 
 
 
The alarm icon will appear and flash when a new system alarm occurs.  Pressing the 
alarm icon will take the user directly to the alarm monitor screen in order to view and /or 
reset the active alarm condition. 
 
 
The left and right navigation arrows will appear on screens that provide additional 
information that the user can scroll to such as the loop view screens, charts or program 
entry screen in order to cycle through each step of a ramp/soak program. 
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NOTE: A single press of the left or right arrows will scroll program steps to the next step or screens 
to the next available loop or chart.  Pressing and holding the arrow keys will continue the item 
scrolling until the last step of the program is reached or the button is released. 

 
IMPORTANT: Do not use any sharp or metal objects on the touch screen as they may damage the surface.  

Also be sure that hands and fingers are free from oils or chemicals which may mar the 
surface of the touch screen. 
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5 Operation   

5.1 General Notes 
• The insulation consists of high-quality 

refractory material which is susceptible to 
shock.  Take care not to knock against the 
refractory material when charging the furnace 
to avoid damage. 

• In order to achieve an even temperature 
distribution the furnace should be charged in 
such a way that products have a certain 
distance to each other and also to the side 
walls.  Koehler offers shelves, etc. so that the 
furnace chamber can be used in the most 
efficient way possible. 

• If the furnace is charged with a high quantity 
of products the heating time may be prolonged 
considerably. 

• The furnace heating is stopped when the door 
is opened and is switched on automatically 
when the door is closed. 

• Do not open the furnace when it is hot.  If the 
furnace must be opened at high temperatures 
do this as quickly as possible.  Wear personal 
protective equipment and clothing and provide 
sufficient room ventilation. 

• Make sure that the door is properly closed 
during heating. 

• Discolorations may occur on the stainless 
steel housing (especially when the hot furnace 
is opened); these, however, do not affect the 
functionality of the oven. 

 
5.2 Maintenance and fault clearance 
 

Regularly clean the ventilation holes/pipes so that 
the ventilation cross-section remains unobstructed 
and the suction functions well. 

In the case of commercial use: 

Please observe the safety regulations 
applicable to your country. 
 
When ordering replacement part(s), please 
provide the model number, serial number, and 
product shipment date of your equipment so that 
we can ensure you will receive the proper 
replacement part(s). 
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5.3 Display Menu Navigation 
 

The display provides the user with the ability to select text based menu navigation, much like the typical file 
menu system of a PC, as well as an icon based navigation system like that of a “smart” device.  The user can 
switch back and forth between the two from the Setup menu. 
 

 
Text Based Navigation 

 
 

 
Icon Based/Slide Page Navigation 

 
The available menu items are dependent upon the OEM configuration of the display.  Not all of the menu 
items shown may be available on your system.  The following information is provided as an overview of the 
full navigational menus for the display. 
 

Home Menu 
The home menu is the top level, default menu provided when the display first powers on.  Pressing the menu 
(monitor) icon will display the main menu offering the selections shown below. 
 

Active Page 
Indicator (1 of 3) 

Touch and drag 
finger across 

screen to switch 
between menu 

pages.  
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Text Based Home Menu 
 

 
 

     
 

 
 

 
 

 
 
 

The View menu provides navigation to all standard view screens.  These 
include the Single and Overall loop views, real time Charts, Alarm monitor, 
Alarm File and Events control screens. 
 
 
 
 
 
 
The Program menu provides access to the automatic ramp/soak program 
actions, Entry and Status views.  The program Start, Hold and Halt menu items 
allow quick access to these functions if a program is already downloaded to the 
display loop controls. 
 
 
 
 
 
 
The Device menu provides access to the display controller settings.  These 
include, loop set point entry limits, alarm set points, communication settings, 
email setup as well as access to offline settings for date/time, etc.   
 
 
 
 
 
 
 
The Security menu provides access for user login, security settings and audit 
trail viewing if the security system is enabled. 
 
 
 
 
 
 
 
 
 
 
The Data menu provides access to data log functions, file utilities, FTP\WAN 
back-up settings as well as the historical data viewer. 
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Icon/Slide Page Based Home Menu 
 

 
 
 

 
 
 

 
 

Slide page 1 provides navigation to 
all standard view screens.  These 
include the Single and Overall loop 
views, Event control, trend Charts, 
Alarm monitor, and Alarm File.   
 
It also provides quick access to the 
display Settings and Data file 
functions which include file utilities, 
FTP\WAN back-up settings as well 
as the historical data viewer. 
 
 
 
 
 
 
 
 
Slide page 2 provides access to 
automatic ramp/soak program 
actions, Entry and Status views. 
 
Start, Hold and Halt program menu 
items allow quick access to these 
functions if a program is already 
downloaded to the display loop 
controls. 
 
 
 
 
 
 
 
 
 
Slide page 3 provides access to 
security settings, Audit trail viewing, 
current User information, user 
Password editing and user Login 
and Log Off functions. 
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Automatic Ramp/Soak Program Menu 
The automatic ramp/soak program menu is provided when the user selects either “Entry” or “Status” from the 
Program menu.  The menu provides all functions related to the creation, editing and operation of programs.  
See section 5 on Automatic Ramp/Soak Program Operation for detailed information on how to create and run 
programs.   

Text Based Program Menu 
 

 
 

 
 

 
 

 
 
 
 

 
 
The View menu provides navigation to the program view screens.  These 
include the Status, Entry and Settings screens. 
 
 
 
 
 
 
 
The File menu provides functions needed to create, open, save and delete 
automatic ramp/soak programs. 
 
 
 
 
 
 
 
 
 
The Step menu provides all of the functions needed to edit programs.  
These include Insert, Remove, Copy and Paste step functions as well as 
the Clone event function which allows the user to transfer the current step 
event selections to all following program steps with a single click to simplify 
and speed program entry. 
 
 
 
 
 
The Program menu provides the program control selections for Start, Hold 
and Stop. 
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Icon/Slide Page Based Program Menu 
 

 
 

 
 
 

 
 
 

Slide page 1 provides navigation to 
the program Status, Entry and 
Settings screens and also provides 
access to the functions needed to 
create, open, save and delete 
automatic ramp/soak programs. 
 
 
 
 
 
 
 
 
 
 
 
 
Slide page 2 provides all of the 
functions needed to edit programs.  
These include Copy, Paste, Insert 
and Remove step as well as the 
Clone event function which allows 
the user to transfer the current step 
event selections to all following 
program steps to simplify and speed 
program entry. 
 
 
 
 
 
 
 
 
 
Slide page 3 provides the program 
control selections for Start, Hold and 
Halt. 
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Device Settings Menu 
The device settings menu is provided when the user selects “Settings” from the main “Device” menu.  See 
section 8 on Device Settings for detailed information on these settings and their use. 
 

  Text Based System Setup Menu 
 

 
 

 
 

 
 

 
 
 
 
 
 

The View menu provides navigation to the manual loop Tuning screen. 
 
 
 
 
 
 
 
 
The Set menu provides access to settings Alarm set points, control loop 
set point Limits, Event tagnames, Navigation type selection and 
Communications options. 
 
 
 
 
 
 
 
 
 
 
The Email menu provides settings for the email server to send SMS text 
messages and/or emails on alarm and allows the user to compose and 
send a Message to any user configured in the system. 
 
 
 
 
 
 
 
The Offline menu provides access to the display offline setup which 
provides the user with the ability to adjust the date/time, calibrate the 
touch screen, configure profile power recovery options, etc. 
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Icon/Slide Page Based Device Settings Menu 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Setup slide page provides 
access to the display controller 
settings.  These include options for 
Navigation type, control loop set 
point Limits, Alarm set points, loop 
Tuning, Event tagname entry and 
Email server settings and 
Messaging. 
 
It also includes access to the 
communications settings for the 
web page, VNC server and 
Modbus user communications. 
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Offline Menu 
The offline menu is provided when the user selects “Offline” from the device settings “Offline” menu.  See 
section 9 on Offline Settings for information on these settings and their use.   
 
NOTE: Offline settings can only be accessed when an automated ramp/soak program is not running and 

data logging is turned off.   
 

  Text Based Offline Setup Menu 
 

 
 

 
 

 
 

 
 
 
 
 

 
 
 
The View menu provides navigation back to the display device settings 
menu. 
 
 
 
 
 
 
 
The Set menu provides access to the profile power Recovery options, 
temperature Units selection, NTS Clock, and Language settings. 
 
 
 
 
 
 
 
 
The Calibrate menu provides access to the user input Offset calibration 
for the control loop inputs. 
 
 
 
 
 
 
 
The System menu provides access to the display settings, import/export 
Configuration utility, About screen and Exit application screen. 
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Icon/Slide Page Based Offline Menu 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

Slide page 1 provides navigation 
back to the device Settings menu, 
Clock, Display settings, About the 
display and Exit application 
screens, temperature Units 
selection, Language, import/export 
Configuration utility and input 
Offset calibration. 
 
 
 
 
 
 
 
 
 
 
Slide page 2 provides access to 
the automated program power 
Recovery options. 
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Data Menu 
The data log menu is provided when the user selects “Data” from the main “Data” menu.  See section 7 on 
Data Logging for information on these settings and their use. 
 

  Text Based Data Logging Menu 
 

 
 

 
 

 
 

 
 

 
 

 
The View menu provides access to the data file Annotation and digital 
Signature screens. 
 
 
 
 
 
 
 
The File menu provides functions for opening and deleting historical data log 
files. 
 
 
 
 
 
 
 
The Data menu provides access to the main Data screen for starting and 
stopping data logging and to the log point Assignment screen where the user 
can select which items are to be logged to the history file. 
 
 
 
 
 
 
 
The Chart menu provides functions for viewing historical data files in graphical 
format. 
 
 
 
 
 
 
 
The Utilities menu provides access to the display file management utilities 
including USB file transfer and FTP/WAN back-up. 
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Icon/Slide Page Based Log Menu 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slide page 1 provides access to 
the main Data log screen and to 
the log point Assignment screen 
where the user can select which 
items are to be logged. 
 
Historical data file functions are 
provided for Opening and Deleting 
historical files and viewing/setting 
data file Annotations and digital 
Signatures. 
 
The plot Set and Chart icons 
provide access to the historical 
data viewer options. 
 
 
 
Slide page 2 provides access to 
the FTP/WAN back-up settings 
and the memory check utility for 
viewing available system/storage 
memory space. 
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Notifications 
The notification window is a feature that can be accessed by pressing the date/time field in the icon bar.  This 
window provides a snapshot of current the display activity.  The notification window can be closed by pressing 
the date/time field again, or is automatically closed if the Menu, Home or an arrow icon is pressed. 
 

 
 
A user can view all notifications by touching the screen and dragging their finger up or down on the list to 
scroll through all items like other lists in the display.  The notifications include the following: 
 

• Loop PV and SP for each loop configured. 
•  Automatic program status including name of running profile. 
• Active alarm status including the most recent alarm. 
•  Data logging status including active file name and the length and logging rate set. 
•  Security status including the current user. 
•  Audit trail active/inactive status. 
•  Web server active/inactive status. 
•  VNC server active/inactive status. 
•  the display IP address. 
•  Available SD storage memory remaining. 

 
The appearance of the items is based on the configuration of the display.  If data logging or security functions 
are disabled in the configuration for example, their status items will be removed from the list as well.   
 
 
NOTE: The notification items do not update while the list is shown.  The information shown in the list is a 

snapshot of the data at the time the window was shown.  Therefore, the PV or SP shown for a 
loop may not be the actual values for the loop if the notification window is left open for extended 
periods of time.  The notification window is not available in the offline setup. 
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Control Loops (Single Set point Operation) 
The loop view screens provide direct viewing options for the control and monitoring of the display control 
loops.  The loop screens allow the user to adjust the current loop set point (SP) and view the process 
variables (PV) and percentages of output (%) for each loop. 
 
 

Single Loop View 
The Single loop view display shows one control loop at a time.  It is accessed from the home “View” menu.  
The screen provides loop control functions not available on the Overall view screen.  These functions are 
accessed by the Manual Control, Start and Halt control buttons.  
 

 
 
The left and right arrow buttons allow you to switch between each loop in the system if more than one loop 
is available.  If the display is configured as a single loop system, the left and right arrow buttons will not be 
shown. 
 
The loop name, shown at the top right of the loop view, will update as each loop is shown.  The unit display 
field will update as well, in order to provide the user with the units of measurement for the selected loop.  
 
The set point entry field is the area where the screen can be touched in order to bring up the keypad entry 
window.  Using the numeric entry keypad, a new set point can be entered.  Once entered, the new set point 
will be shown in the set point entry field.  Adjustment of the set point is locked out if an automated ramp/soak 
program is running. 
 
 
IMPORTANT: When operating in single set point mode, the set point is saved in the loop control board’s 

memory once every 5 minutes.  If the set point is changed and power is removed prior to the 
5 minute time period, when power is re-applied, the loop set point will return to the previous 
value.  Make sure that power remains on the unit for 5 minutes after a set point change in 
order to have it power-up with the desired set point the next time power is applied. 

 
 
 
 
 
 

Set Point Entry 
Field 

Loop Units 

Loop Name 

Cycle Test Current Program 
Loaded/Status 
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The loop control function buttons are used to define the mode of operation of the loop. 
 
Manual Control -  This button switches the loop mode between automatic and manual operation.  

When the loop is in automatic mode, the loop will automatically adjust its output based 
on its PID settings.  When the loop is in manual operation, the percentage of output for 
the loop can then be set manually, to a fixed output percentage. 

  
To switch the loop between auto and manual operation, press the button to place the 
loop in auto or manual mode.  When in manual mode, the button’s indicator will be on.  
To adjust the loop output percentage when in manual operation, touch the percent 
output display field and enter the desired percentage of output.  If the loop is 
configured for heat/cool operation, enter a positive value for heating and negative 
value for cooling. 

 
Start -  This button starts the automatic ramp/soak program currently loaded in the loop 

control.  During program operation, the button text will change to “Hold”.  Pressing the 
button will place the program in hold.  Pressing the button again will resume the 
program.  

 
Halt -  This stops the automatic ramp/soak program running in the loop control.  The loop 

will be places back into the single set point (static) mode of operation.  
 
 
NOTE: If the automatic ramp/soak program mode setting is set to “All”, the current program loaded field 

and start/halt buttons will display and control the program loaded in the “primary” loop control.  The 
program mode and primary loop are adjusted on the program Settings screen.  See section 5, 
Automatic Ramp/Soak Program Operation for more information. 

 

Overall Loop View 
The Overall loop view provides a list of all loops configured in the system.  It is accessed from the home 
“View” menu.  If the display is configured as a single loop system only loop one will be shown.  The screen 
allows manual set point entry for each loop by touching the respective row. 
 

 
 
NOTE: If the automatic ramp/soak program mode setting is set to “All”, the current program loaded field 

for the primary loop will display the program information.  All other “slave” loops will indicate that 
they are under set point control of the primary loop by displaying the name of the primary loop in 
parenthesis.  See section 5, Automatic Ramp/Soak Program Operation for more information. 

Current Program 
Loaded/Status 
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Event Control 
Events are the “switches” used to turn the digital outputs of the display loop controls on and off.  These 
events can be manually turned on and off as well as programmed into automatic ramp/soak programs so that 
they can be turned on and off at set time intervals. 
 
NOTE: The display loop controls can provide up to 3 event outputs each (for a total of 30 events).  

Depending upon the configuration of the display, some outputs may perform specific control or 
alarm functions.  The use of each output, and what it controls, is determined by the system 
designer.  If there are questions or concerns about the configuration and operation of your the 
display controller, contact your OEM for further information.  Only your OEM can address 
equipment related issues. 

 
The names of events are also determined by the system designer.  The screen shot below is an 
example showing factory default event names.  Consult section 8.3 on Event Names in order to see 
how to change the names of events. 

 

 
 
To turn the events on and off, select “Events” from the home “View” menu.  Press the switch for each event 
that you want to turn on or off to toggle the on/off state of the event.  When an automatic ramp/soak program 
is running on the loop control that the event is tied to, the event cannot be manually controlled.  During 
program operation, the event is controlled by the running program.  The program must be stopped in order to 
control the event manually. 
 
When running a program in the “All” mode, only the events tied to the primary loop are controlled by the 
program.  All events tied to the individual “slave” loops can be manually controlled. 
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Process Monitoring 
The loop view screens provide the current process values of the display.  In order to view the process inputs 
over time, the display provides real-time charts.  Four user configurable charts are provided with up to eight 
plot points per chart. 
 
 

Charts 
The Chart screen is accessed from the home “View” menu.  The real-time charts can be configured to display 
the process variable (PV), set point (SP) and percentage of output (%) of each control loop over a selectable 
period of time.  The vertical axis determines the range of displayed data while the horizontal axis determines 
the history period.  The maximum time period that can be shown in a chart is 24 hours. 
 
The rate at which the chart plots a new point is based on the time period to be shown.  Each buffer can hold a 
total of 720 readings for each of the selected channels to plot.  The update rate can be calculated by the 
formula:  time period (in minutes) * 60 / 720.  Note that for time periods less than 72 minutes, the update rate 
will be held to a minimum of 6 seconds.  Thus, the update rate will vary from a minimum of 6 seconds (for 
time periods of 72 minutes or less) up to a maximum of 120 seconds for 1440 minutes (24 hours).  
 

 
 
The Labels button allows the user to cycle through each of the configured plot channels to determine what 
each colored plot represents as well as view the current value without having to return to the Single or Dual 
view screens.  The left and right scroll buttons at the upper right of the screen allow the user to cycle through 
each of the four available charts. 
 
The charts also allow you to “zoom in” on a particular area to have a more detailed look at current data.  By 
using your finger to select an area on the screen, the chart will zoom in on that area.  To select a portion of 
the plot, touch and hold the screen with your finger.  Drag your finger across the graph and a box will be 
drawn around the selected area.  Removing your finger from the screen will cause the chart to redraw with 
only the selected plot area.  To return to the normal view, touch the ‘X’ or ‘Y’ axis and select zoom out to 
return to the previous zoom setting or zoom normal to return to the full display. 
 
 
NOTE: When a chart is zoomed in, it will not update with new information.  The chart must be in normal view 

mode in order to update at each time interval.  The chart will return to normal automatically when 
selecting a different screen to view. 
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Chart Setup 
 
To configure a chart, press the “Set” button in the upper right corner of the display.  The setup screen will be 
shown.  To assign channels to the chart, simply touch the on/off button for the desired items in the list to 
select them.  Select the left or right vertical axis for each item by selecting the item in the list and press the 
button for the desired “Left” or “Right” axis.  The left axis is the default axis selection.  If none of the channels 
are assigned to the right axis, the axis will not be shown on the chart.     
 

 
 
Once the channel selections have been made, press the “Axis” button to adjust the time period and vertical 
axis ranges of the graph. 
 

 
 
Time Period - Adjusts the displayed time period for the graph.  The allowable range is from 4 to 

1440 minutes (24 hours). 
 
Maximum - The maximum value sets the maximum range of the vertical access with a 

minimum value of -32,760 and a maximum of 32,760. 
 
Minimum - The minimum value sets the minimum range of the vertical access with a minimum 

value of -32,760 and a maximum of 32,760. 
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Automatic Scale - When on, the vertical axis will automatically adjust its zero and span as needed to 
display the selected plot channels. 

System Alarms 
When an alarm condition occurs, the alarm icon flashes in the display icon bar, to provide a visual indication 
of an alarm condition.  An audible alarm will also sound if the alarm requires immediate operator attention 
such as a loop communications failure or a process alarm set point has been exceeded.  For more 
information on adjusting the audible alarm volume, see Section 9.12.3, Alarm Volume. 
 
NOTE: The display loop controls can provide up to 3 alarm outputs each (for a total of 30 alarms).  

Depending upon the configuration of the display, some outputs may perform specific control or 
event functions.  The use of each output, and what it controls, is determined by the system 
designer.  If there are questions or concerns about the configuration and operation of your the 
display controller, contact your OEM for further information.  Only your OEM can address 
equipment related issues. 

 
   
 
 

Alarm Monitor 
The Alarm screen is accessed from the home “View” menu.  It can also be displayed by pressing the alarm 
icon whenever a new alarm occurs.  It displays all current and/or previously acknowledged alarms according 
to time and date of occurrence.  Once the alarm is reset, the alarm icon will be hidden; however, the alarm 
condition may still be present. 
 

 
 
The alarm will be removed from the list when cleared by the operator by pressing the “Clear” button.  Only 
alarms that are not currently active in the system can be cleared from the alarm list. 
 
 
IMPORTANT: If a control loop is in manual mode or in automatic tune and the reset button is preset, the 

alarm reset will terminate automatic tune or manual mode and place the loop back into 
normal operation. 

 
 Upon alarm reset, if the process no longer exceeds the alarm set point, but the alarm output 

has not yet reset due to the alarm hysteresis, the alarm reset will ignore the alarm hysteresis 
and the alarm output will immediately go to the non-alarm output state. 
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Alarm File 
The Alarm File screen is accessed from the home “View” menu.  It displays all alarms for any given day.  the 
display can store daily alarm files for a period of a year or longer (time based on storage usage for data 
history).  Each time an alarm occurs on the display, the alarm is written to a file.  Alarm file names are listed 
as month_day_year.  The “Open” file button will display a dialog box where the user can select any alarm file 
to view. 
 
NOTE: If no alarms occurred on a given day, an alarm file will not be created for that day. 
 

 
 
The send email icon  allows the user to send a copy of the currently opened alarm file to any user 
configured in the display.  When the email icon is pressed, an “Add Recipients” window will be displayed 
where the user can select recipients for the file from any of the email addresses configured under the display 
email settings. 
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Automatic Ramp/Soak Program Operation 
A ramp/soak program is a set of instructions (set points and events) programmed as a timed sequence of 
steps.  When a program is run, the display executes each step of the program automatically, in sequence, 
based on the time duration and settings for each step.  the display can store hundreds of automatic ram/soak 
programs (depending on storage usage for data history) with up to 64 steps in each program. 
 
 
The menu provides navigation to the following functions: 
 

 
 

 
 

 
 

 

View menu 
Status:  View program operation; step #, time remaining, etc. 
Entry:   Functions for creating/editing programs. 
Settings:  Set program operating mode and primary loop. 
 
 
 
 
 
 
File menu 
New:   Clears all current program entries. 
Open:   Provides file open dialog to select a program 
from memory. 
Save:   Saves the current program being edited. 
Save As:  Saves the program being edited under a new 
name. 
Delete:  Deletes the current program from internal memory. 
 
 
 
 
 
Step menu 
Insert:   Inserts a step into the program at the current step 
number. 
Delete:  Deletes the current step. 
Copy:   Copies current step data including events. 
Paste:   Pastes previously copied step data to the current 
step. 
Clone:  Copies and pastes current step events to all following 
steps. 
 
 
 
Program menu 
Start:   Transfers current program to loop control(s) and 
starts it. 
Hold:   Places a running program in hold. 
Halt: Stops a running program and returns the loop controls to 

single set point (static) operation.  
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Program Settings 
The program settings are used to select the mode of operation for the automatic ramp/soak programs.  The 
program Settings screen is accessed from the “Program” menu. 
 

 
 
The Single mode selection button allows each control loop to run independently of the others.  Programs are 
then downloaded separately to each loop control.  The user can then individually start and stop the program 
in each loop control.  Any combination of loop controls can then be operated in single set point (static) mode 
or automatically via the program at any given time.    
 
The All mode selection button links all loop controls into a master/slave program operation.  While in single 
set point (static) mode, each loop control operates independently from the others.  However, when an 
automatic program is started, the loop defined as the “Primary” loop becomes the master and all other loops 
become set point slaves. 
 
When the ramp/soak program is started in the primary loop, the display will automatically set the set point of 
all other (slave) loops to match the set point of the primary loop.  The user will be unable to manually change 
the loop set points of the slave loops during program operation.  However, any events tied to the slave loops 
can be manually turned on and off during program operation.  Only events tied to the primary loop will be 
controlled via the automatic ramp/soak program. 
 
The Primary loop selection is used to select which loop is to be used as the master loop when operating 
under the “All” program mode. 
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Entering a Ramp/Soak Program 
Ramp/Soak programs are created and edited from the program Entry screen.  The program Entry screen can 
also be accessed directly from the “Program” menu.  To create an automatic ramp/soak program: 
 
1.) From the File menu, select “New” to create a new program. 
 
2.) Enter the number of steps that will be in the program you want to create.  The default setting, and 

minimum number of steps is two.  You can only adjust settings for step numbers within the range of 2 to 
the Max Steps entered (maximum of 64).  Thus, to adjust settings for step 5, you must have the Max 
Steps set to a value of at least 5. 

 
NOTE: The number of steps can be changed at any time during the program entry to shorten or 

lengthen the program as required without affecting steps already programmed.  
 
3.) For each step, enter the step events, set point(s) and time duration or ramp rate (depending upon the 

ramp units selection).  Example shown below with step time (HH:MM). 
 
4.) From the File menu, select “Save” to save the program. 
 

NOTE: Programs can be saved with names of up to 16 characters long.  However, the display only uses 
the first 14 characters of the program name for display updates and record keeping.  When 
naming programs, try to keep the name limited to 14 characters in order to have the full program 
name shown, or use the first 14 characters as a means of more clearly identifying the program 
when more than 14 characters are used in the name.  

    

 
 

The Ramp units selection is a global selection that applies to all steps of the program.  It allows the user to 
select the method of ramp step entry.  Selections include ramp entry in units of time as either hours and 
minutes (hh.mm) or minutes and seconds (mm.ss) and entry in rate of change as units/hour or units/minute. 
 
The Soak units selection is a global selection that applies to all steps of the program.  It allows the user to 
select the method of soak step entry.  Selections include units of time as either hours and minutes (hh.mm) or 
minutes and seconds (mm.ss).   

 
The Hold band entry is global setting that apply to all steps of the program.  If holdback is enabled on a ramp 
or soak step, this value will by applied to the current set point to determine if the process value is within the 
allowed deviation from set point.  If outside of the allowed deviation, the program will be automatically placed 
into hold until the process value recovers within the band. 
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Setting Step Set Points and Time 
Programs are entered as a sequence of ramp and soak steps which define the set point and length of time 
that a loop should remain.  The ramp and soak units can both be set for hours and minutes, minutes and 
seconds or one can be set for hours and minutes while the other is set for minutes and seconds. 
 
Set point entry is only provided when entering a ramp step.  If “soak” is selected for the step type, the loop will 
remain at the previous set point for the amount of time entered for the step.  The set point entered is used as 
the target set point for the step, i.e., the set point the control loop will arrive at by the end of the step.  
 
To enter the set point and/or time for a step, touch the time/set point list view at the bottom of the Entry 
screen.  This will display the “Step Data” screen.  Begin by selecting the desired ramp or soak step type 
(available selections are ramp, soak, jump and end).  The jump and end step types are discussed in the 
following sections. 
 
To enter the set point for the step, touch the set point field and enter the desired set point.  To enter the step 
time, touch the time field to enter in the desired time duration.  Time is entered as HH.MM or MM.SS 
depending upon the selection chosen on the entry screen.  To make time entry easy, the entry will 
automatically be formatted into time as the number keys are pressed.  To enter a time of 1 hour for example, 
you would enter a value of 100 for one hour and zero minutes.  To enter a step time of 30 minutes, the time 
entry would be made as 30.  If the time selection was in minutes and seconds, an entry of 1 minute and 30 
seconds would be made as 130.   
 
Since one minute and thirty seconds is also a time of 90 seconds, you can also enter a value of 90.  Upon 
pressing the ‘Done’ button, the time will be formatted and displayed in the step data list view as 1.30 for 1 
minute and 30 seconds. 
 

  

 
     Ramp Step Entry        
 Soak Step Entry 
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NOTE: A step time of zero can be entered for a step to implement an immediate set point change.  When 
coupled with a hold back condition on the following step, there is no need to know the time it takes 
for the process to reach set point.  The hold back condition can be used to trigger the next step, 
typically a soak, so that the desired soak time is achieved without having to determine what 
additional time may be needed in order to make sure that the process reaches set point before 
starting the soak time. 

 
 
 
 

Setting Step Set Point and Ramp Rate 
If the ramp units are set for units/hour or units/minute, ramp steps are entered in process units/time period.  If 
the user enters a set point that matches the set point of the previous step, the step will be skipped since the 
loop is already at set point.      
 

   
 
 

Setting Step Events 
For each step of the program, the user can select which events are to be on during the step.  To edit step 
events, press the “Events” button on the program Entry screen.  This will display the step Events screen.   
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You can then select which events are to be on during the step by touching the on/off button for each event to  
toggle the events on or off.  Pressing the left or right arrow button will allow you to scroll through each step of 
the program and not have to leave the step Events screen.  To return to the Entry screen, press the “Return” 
button or select “Entry” from the View menu. 
 
IMPORTANT: The events displayed on the program entry events screen are those configured for the 

“primary” loop, whether the program mode is set to “Single” or “All”.  To view events for a 
specific loop, set the primary loop on the program settings screen to the desired loop you 
wish to create the program for.  While a program can be downloaded and run on any loop in 
the system, if the event selections do not match the configuration of the loop (events 
assigned to different outputs), the event output will not turn on when the program is run. 

 
Events cannot be set for the End step.  During program operation, when the End step is reached, the event 
outputs will return to their previous static setting (prior to starting program operation).  If the loop controls are 
configured for “Final SetPoint” at end of program operation, the program will remain in the end step state and 
all event outputs will turn off and remain off until the user halts program operation.  Upon stopping the 
program, the event outputs will then return to their static settings.  
   
NOTE: The step events must be set individually for each step.  Even though a ramp/soak program may be in 

operation, if the events are not set, the associated loop control output will not turn on.  To make 
setting step events quick and easy, the display provides the “Clone” function from the “Step” menu.  
When selected, all event selections of the current step will be copied to all following steps. 

 
This requires the user to only enter event selections for one step (step 1 for example), and if all 
following steps use the same event selections, selecting “Clone” from the “Step” menu will then copy 
the selections to all other steps of the program.   This feature can be used on any step of the 
program, so if event selections then change on step 5, the function can be used again and all steps 
after step 5 will then have event selections of step 5 copied to them leaving steps 1-4 with the 
previous selections. 
 

Setting Jump Steps 
This feature allows the program to jump back to a previous step in order to repeat certain sections of a 
program.  When a jump step is entered, the program will jump to the specified “jump step” rather than 
continuing on to the next step in the program.  After all of the programmed jump cycles have been completed, 
the program will then continue to the next sequential step without making any further jumps. 
 

 
 



K244XX Programmable Ashing Furnace 
Operation and Instruction Manual 

 

K244XX-Manual     -33- 

To program a jump step, select jump for the step type and enter the step number that you want the program 
to jump back to along with the total number of times the jump is to be made.  A cycle count of one indicates 
that no jump will be made since one cycle is completed upon reaching the jump step. 
 
 
NOTE: the display has the ability to do nested looping by allowing multiple jump steps to be programmed 

throughout a program.  The Status screen will provide the current cycle count; however, this is the 
cycle count of the current jump loop that the program is in.  If nested jump loops are programmed, 
this can cause operator confusion if they do not know which jump loop the program is currently in 
based on the current step number.   

 
 

Setting the End Step 
All programs require that the last step is entered as an “End” step type regardless of the length (2 to 64 steps) 
of the program.  The end step type provides a cycle count entry which makes it easy for the operator to 
repeat an entire program without having to enter a jump step.  The end step cycle count can be set from 1 to 
9999 cycles.  An entry of 10,000 can also be made which signifies infinite looping.  If the user enters 10,000 
for the cycle count, the program will repeat indefinitely until stopped by the user.  
  

 
 
If the display is configured for automatic program final set point entry, the set point field will be present.  When 
the program ends, the set point entered on the end step will be used as the loop set point.  The loop control 
will then remain at that set point until the user halts the program.  The loop control will then return to the 
previous static set point (prior to the start of the program) once the program is stopped.  
 
The display configuration also provides the option for having the loop control return to the static mode of 
operation when the program is completed.  When configured to use the last control set point, the loop controls 
will automatically return to the previous static set point (prior to the start of the program) when the program 
ends.  If there are questions or concerns about the configuration and operation of your the display controller, 
contact your OEM for further information.  Only your OEM can address equipment related issues. 
 
NOTE: When configured for automatic program final set point entry, the display will remain in the end step 

until the user manually stops the program. If any loop control outputs are configured as events, they 
will remain in the off state and cannot be turned back on until the program is stopped.   
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Hold Back Operation 
The hold back band setting on the Entry screen is used to set the control tolerance of the loop during the 
steps that have hold back enabled.  When the loop process variable deviates from its set point by more than 
the band value, the program timer will stop until the process variable re-enters the hold back band.  The entry 
applies to every step in the program and only needs to be set once.  

 
To enable hold back on a step, select the hold back type to use.  When the step executes, the program will 
automatically enter a hold condition if the loop’s PV deviates from its set point by more than the hold back 
band setting.  There are four available hold back modes to choose from:  
 
Off  Disables hold back so no action is taken. 
 
Dev Lo Deviation low hold back places the program in hold when the process value deviates below the set 

point by more then the hold back band. 
 
Dev Hi Deviation high hold back places the program in hold when the process value deviates above the set 

point by more then the hold back band. 
 
Band Deviation band hold back is a combination of both the deviation low and high hold back types.  It 

places the program in hold when the process value deviates above or below the set point by more 
then the hold back band. 

 
 
NOTE: When running an automatic program in the “All” mode, only the primary loop is monitored for the 

holdback condition.  All additional (slave) loops are not monitored for holdback.  If there is a need to 
monitor the slave loops and place the program in hold if they deviate too far from set point, it will be 
necessary to configure the slave loops with deviation alarm outputs. 

 
The deviation alarm outputs can then be wired into the event input of the primary loop.  With the 
event input of the primary loop configured as an “automatic program hold” input, the program running 
in the primary loop will be placed in hold whenever a slave loop deviates too far from set point.  When 
the deviation alarm deactivates, the program will then resume operation.  Note that the deviation 
alarm set points for each loop will have to be manually entered to match the holdback band as set in 
the running program. 

 
 
Starting an Automatic Ramp/Soak Program 
In order to start an automatic ramp/soak program, it must first be loaded into the display control loop.  In order 
to do this, you must select “Start” from the Program menu. 
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The screen will automatically change to the Start screen.  By default, a program will always start on step 1.  If 
you wish to start the program on a different step, press the start step field and enter the desired start step or 
use the left and right skip buttons to adjust the step number. 
 

 
 
Select the desired loop to download and start the program on using the drop down selection.  If only one loop 
is configured in the system, or the program mode is set to “All”, the loop selection will not be visible.  When 
the program mode is set to “All” on a multi loop system, program operation is automatically defaulted to the 
primary loop.   
 
     
Once the desired loop has been selected and the start step number is entered, press the “Start” button.  The 
program will then be transferred to the loop control and started once the transfer is complete.  The Status 
screen will then be automatically displayed. 
 
To stop a program, select “Stop” from the Program menu.  When a program is stopped, the loop set points 
and events will revert back to the single set point (static mode) values that were entered prior to the program 
being started. 
 
NOTE: When the program operating mode is set to “Single” and more than one loop is configured in the 

system, the “Halt” menu selection will prompt the user to select a loop to perform the action on prior 
to stopping a program.  If only one loop is configured, or the program mode is set to “All” on a multi 
loop system, the program will be stopped on the primary control loop. 

 
 

Hold/Resume Ramp/Soak Program Operation 
At any time during the operation of a program, it can be manually placed into hold.  This stops the program 
timer; however, the display continues operation under the current step settings at the time the program was 
put into hold.  To pause a program, select “Hold” from the Program menu.  To resume the program from the 
point in which it was paused, select “Start” from the Program menu. 
 
NOTE: When the program operating mode is set to “Single” and more than one loop is configured in the 

system, the “Hold” menu selection will prompt the user to select a loop to perform the action on prior 
to placing a program in hold.  If only one loop is configured, or the program mode is set to “All” on a 
multi loop system, the program will be placed in hold on the primary control loop. 
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Monitoring Automated Ramp/Soak Program Operation 
The program Status view provides all information regarding the operation of a program for each control loop 
configured in the system.  When a program is first started, the display automatically directs the user to this 
screen to observe program operation for the loop the program was started on. 
 

 
 
The Status field indicates the current operating mode of the program, i.e., Active, In Hold and Inactive. 
 
The Cycles field indicates the number of cycles left to be completed for the current jump loop. 
 
The Steps field indicates the total number of steps in the current program. 
   
The Step field indicates the step number currently being executed. 
 
The Time field indicates the total length of time programmed for the current step. 
 
Time Remaining is the time remaining in the current step. 
 
The loop SP indicates the programmed set point for the loop that will be achieved by the end of the step.  The 
field will indicate the current ramp or soak status for the loop based on the set point of the step.  If the target 
set point of the step is greater than the loop set point, “ramp up to” will be displayed.  If the set point is lower 
than the current loop set point, “ramping down to” will be displayed.  If the step is a soak step or the target set 
point is the same as the current loop set point, “soak at” will be displayed. 
 
The loop PV displays the current process value of the loop. 
 
The name of the running program, or current program loaded to the the display loop control, will be shown at 
the bottom center of the screen.  If no program has been loaded, the field will be empty. 
 
 
IMPORTANT: If the set point does not match the set point programmed for the step, check the lower and 

upper set point limits. The lower and upper limits define the allowed operating range.  If a 
step set point exceeds a limit, it will be coerced to the lower or upper limit that it exceeds.  
This is done automatically without altering the original program. 
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Common Questions About Ramp/Soak Program Operation 
 
1. How do I start or run a ramp/soak program? 
 
To select and start a program, you must be on the ‘Entry’ or ‘Status’ screen.  Using the File menu, choose the 
‘Open’ menu item to select from a list of all available programs stored on the display.  Open the desired 
program from the list, and then select ‘Start’ from the Program menu.  Enter the desired start step and select 
the loop to start the program on, then press the ‘Start button. 
 
       
2. How do I know which program is running? 
 
When a program is running, the name is displayed on Status view screen as well as the Single and Overall 
loop view screens.  the display will indicate that the program is running when it is in operation.  If a program is 
not running, the display will display the name of the currently loaded program, i.e., present in memory and 
ready to be run. 
 
 
3 Why is the program not running to the set point entered for the step? 
 
Automatic ramp/soak program operation is limited by the lower and upper set point limits (see section 8.3 
Setpoint Limits).  If a program step has a set point that exceeds the lower or upper limit, the set point will be 
automatically coerced to the limit it exceeds.  This prevents damage to equipment or product by insuring that 
the system only operates to the range entered by the user.  If a program step has a set point of 100 for 
example, but the upper limit is 90, when the program is run the set point will be coerced to the maximum 
allowed upper limit of 90 during operation of the step. 
 
The original program remains unaltered, so if the user then changes the lower and upper limits to match the 
range of set points within the program, the program will then operate to the programmed set points.  This 
insures that the operating range of the system can not be exceeded even if a user accidentally copies a 
program from another system with a greater operating range. 
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6 Service Trouble Shooting 
 

6.1 Replacing the heating plates or heating coil  
Removal 

• Remove the rear cover 

• Disconnect the power wires to the heaters and the thermocouple wires at the terminal block 

• Open the front door and remove the two screws on each side of the vertical stainless steel shelf lip 

• From the rear, remove the entire heated chamber/insulation/element package 

• Replace the entire heated chamber/insulation/element package as a unit 
 
Insertion 

• Clean furnace chamber and exhaust stack from residues 

• Insert a new heated chamber/insulation/element package from the rear of the furnace 

• Open the front door and install the two screws on each side of the vertical stainless steel shelf lip 

• Re-connect the power wires to the heaters and the thermocouple wires at the terminal block 
• Auto Tune the control system after installing the new heated chamber and perform the Initial heating 

procedure as outline in the beginning of this manual 

Replacing the thermocouple  

• Remove the rear cover 

• Disconnect the thermocouple wires at the terminal block 

• Loosen the compression fitting and remove the thermocouple.  If the thermocouple was supplied with 
a new compression fitting, replace the old one with the new one 

• Connect new thermocouple (observe correct polarity!) 

• Install the rear cover 
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7 Wiring Diagram 
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8 Service 
 

Under normal operating conditions and with 
routine maintenance, the K244XX, Ashing furnace 
should not require service. Any service problem 
can be quickly resolved by contacting Koehler’s 
technical service department either by letter, 
phone, fax, or email. In order to assure the fastest 
possible service, please provide us with the 
following information. 

 
Model Number:       

Serial Number:       

Date of Shipment:       
 
 
9 Storage 

 
This laboratory test instrument is equipped with 

electrical components. Storage facilities should be 
consistent with an indoor laboratory environment. 
This testing equipment should not be subjected to 
extremes of temperature and/or moisture. 

 
This equipment was shipped from the factory in 

a corrugated cardboard container. If long term 
storage is anticipated, re-packing the instrument in 
a water-resistant container is recommended to 
ensure equipment safety and longevity. 
 
10  Warranty 

 
We, at Koehler, would like to thank you for your 

equipment purchase, which is protected by the 
following warranty. If within one (1) year from the 
date of receipt, but no longer than fifteen (15) 
months from the date of shipment, Koehler 
equipment fails to perform properly because of 
defects in materials or workmanship, Koehler 
Instrument Company, Inc. will repair or, at its sole 
discretion, replace the equipment without charge 
F.O.B. its plant, provided the equipment has been 
properly installed, operated, and maintained. 
Koehler Instrument Company must be advised in 
writing of the malfunction and authorize the return 

of the product to the factory. The sole 
responsibility of Koehler Instrument Company and 
the purchaser’s exclusive remedy for any claim 
arising out of the purchase of any product is the 
repair or replacement of the product. In no event 
shall the cost of the purchaser’s remedy exceed 
the purchase price, nor shall Koehler Instrument 
Company be liable for any special, indirect, 
incidental, consequential, or exemplary damages. 
KOEHLER INSTRUMENT COMPANY, INC. 
DISCLAIMS ALL OTHER WARRANTIES, 
EXPRESSED OR IMPLIED, INCLUDING ANY 
IMPLIED WARRANTIES OF FITNESS FOR A 
PARTICULAR PURPOSE. Please save the 
shipping carton in the event the equipment needs 
to be returned to the factory for warranty repair. If 
the carton is discarded, it will be the purchaser’s 
responsibility to provide an appropriate shipping 
carton. 

 
10 Returned Goods Policy 

 
To return products for credit or replacement, 

please contact Koehler Customer Service with 
your purchase order number, our packing 
list/invoice number, the item(s) to be returned and 
the reason for the return. You will be issued a 
Returned Authorization (RA) number, which must 
be prominently displayed on the shipping 
container when you return the material to our 
plant. Shipping containers without an RA number 
prominently displayed with will be returned to the 
sender. Goods must be returned freight prepaid. 
Returns will be subject to a restocking charge, the 
application of which will depend upon the 
circumstances necessitating the return. Some 
returns cannot be authorized, including certain 
products purchased from outside vendors for the 
convenience of the customer, products 
manufactured on special order, products shipped 
from the factory past ninety (90) days, and 
products which have been used or modified in 
such a way that they cannot be returned to stock 
for future sale. 
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Notes 
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Notes 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 


	1 Introduction
	1.1 Koehler’s Commitment to Our Customers
	1.2 Recommended Resources and Publications
	1.3 Instrument Specifications

	2  Safety Information and Warnings
	3 Getting Started
	3.1 Unpacking
	3.2 Setup

	4 Temperature Controller
	4.1 Description of Controller
	4.2 Basic Controller Operation
	Touch Screen Interface

	5  Operation
	5.1 General Notes
	5.2 Maintenance and fault clearance
	5.3 Display Menu Navigation
	Home Menu
	Text Based Home Menu
	Icon/Slide Page Based Home Menu

	Automatic Ramp/Soak Program Menu
	Text Based Program Menu
	Icon/Slide Page Based Program Menu

	Device Settings Menu
	Text Based System Setup Menu
	Icon/Slide Page Based Device Settings Menu

	Offline Menu
	Text Based Offline Setup Menu
	Icon/Slide Page Based Offline Menu

	Data Menu
	Text Based Data Logging Menu
	Icon/Slide Page Based Log Menu


	Notifications
	Control Loops (Single Set point Operation)
	Single Loop View
	Overall Loop View

	Event Control
	Process Monitoring
	Charts
	Chart Setup


	System Alarms
	Alarm Monitor
	Alarm File


	Automatic Ramp/Soak Program Operation
	Program Settings
	Entering a Ramp/Soak Program
	Setting Step Set Points and Time
	Setting Step Set Point and Ramp Rate
	Setting Step Events
	Setting Jump Steps
	Setting the End Step
	Hold Back Operation

	Starting an Automatic Ramp/Soak Program
	Hold/Resume Ramp/Soak Program Operation

	Monitoring Automated Ramp/Soak Program Operation
	Common Questions About Ramp/Soak Program Operation

	6 Service Trouble Shooting
	6.1 Replacing the heating plates or heating coil

	7 Wiring Diagram
	8 Service
	9 Storage
	10  Warranty
	10 Returned Goods Policy
	Notes
	Notes

